Chapter 3

Configuring Hyper-V

MICROSOFT EXAM OBJECTIVES COVERED IN THIS CHAPTER:

✓ Managing and Optimizing the Hyper-V Server
  ▪ This objective may include but is not limited to: VHD (virtual hard disk) location, snapshot location, System Center Virtual Machine Manager (SCVMM), Authorization Manager, release key.

✓ Configure Virtual Networking
  ▪ This objective may include but is not limited to: Virtual Network Manager tool, SCVMM, virtual switches, VLAN tagging, external/private/internal switches.

✓ Configure Remote Administration
  ▪ This objective may include but is not limited to: Hyper-V manager on Windows Server 2008 and Windows Vista, WMI, WinRM, firewall settings, RDP.
Hyper-V, like any other software product, should be configured after installation so that you can maximize the virtualization performance.

This chapter begins by exploring some of the Hyper-V terms and concepts needed to configure Hyper-V. We will also discuss the configuration of virtual networking, including how to configure your virtual and nonvirtual switches, the Virtual Network Manager, and the System Center Virtual Machine Manager (SCVMM).

Next you will learn how to configure Hyper-V remotely using Windows Server 2008 and Windows Vista. We will cover the Microsoft Windows Firewall and Remote Desktop Protocol (RDP). Finally, we will discuss Windows Management Instrumentation (WMI) and Windows Remote Management (WinRM), and you will learn how using these utilities can better help you configure and maintain your Hyper-V environment.

So let’s begin by exploring some of the tools and techniques you need to configure the Hyper-V role properly.

Understanding the Configuration Tools and Techniques

It is always important to configure any application properly to allow that application to work at peak performance. Hyper-V is no different. By configuring Hyper-V, you are reducing the chances that any problems will occur down the road.

Configuring an application can be the most important and sometimes the most difficult task that you can complete. The time that you spend on the configuration now will be time that you save on fixing the application later.

Hyper-V has many variables that can you configure, from the virtual hard disk to the memory used for the virtual machine. First let’s define some terms and concepts you should be familiar with.

**Host Server (Parent Partition)** The host server is the Windows Server 2008 machine that hosts the Hyper-V role and executes the Hyper-V virtual machines. The host server is also known as the parent partition.

**Guest (Child Partition)** These are the containers (virtual machines) that run the guest operating system. The virtual machines are referred to as the guest, or child, partition. These virtual machine systems can have operating systems running other than Microsoft.
Virtual Hard Disk (VHD)  When you're installing an OS onto a computer, you determine the size and location of the hard disk that you want to install the operating system on. A virtual hard disk (VHD) is the same for the virtual environment. When you install a guest system using Hyper-V, the VHD is the hard disk space you are using for that install.

VMBus  The parent and the child partitions use a new high-speed communication protocol for Hyper-V hardware called VMBus. As you learned in Chapter 1, the Microsoft hypervisor handles the interaction between multiple virtual machines running on the same host. VMBus handles many of the hardware communications, such as disk, networking, video, and input/output communications.

Host Clustering  To make Hyper-V more available on your network, you can install and run the clustering role on one or more Hyper-V servers. This type of clustering is called host clustering. An advantage of clustering is that if one of the servers goes down, the other servers in the cluster take up the extra load and continue to allow the cluster to run properly. (Hyper-V clustering is covered in full detail in Chapter 7, “Hyper-V and Failover Clusters.”)

Operating System Partitioning  When setting up Hyper-V, you normally create two partitions: the parent and the child partitions. The parent partition manages the memory and virtual devices; the child partitions are the virtual machines. You can have as many child partitions as needed, but your Hyper-V can have only one parent partition. The child partitions can contain both 32-bit and 64-bit operating systems loaded on the virtual machine.

Now that you have a few basic terms and concepts down, let’s start our Hyper-V configuration with VHDs.

Understanding Virtual Hard Disks

There are two main types of virtual hard disks (VHDs): fixed-size or dynamic. When setting up either of these VHDs, you determine the size of the VHD, and that will represent how large the disk will appear to the virtual machines. The maximum size that you can choose for either VHD is 2,040GB.

Fixed-size VHDs have a set amount of hard disk space and that amount does not change. For example, if I designate 16GB to a fixed-size VHD, then the VHD will take up all 16GB on the hard disk immediately—regardless of how much the system is actually using.

Dynamic VHDs only use the amount of space that is currently being used for the VHD. For example, if a dynamic VHD has 16GB allotted to it but it’s only using 7GB, only 7GB will be used by the system. This is how you want to set up your VHD if hard drive space is limited on your server. However, the fixed-size VHD option offers better performance by eliminating the fragmentation associated with a growing file. Figure 3.1 shows the Choose Disk Type screen of the New Virtual Hard Disk wizard.

When setting up your VHD, there is a third option you can choose called differencing. A differencing disk is configured in a parent-child relationship with another disk that is left intact. This approach allows you to change the operating system or data without affecting the parent disk.
**FIGURE 3.1** Choosing the VHD disk type

Differencing can help Hyper-V by reducing hard drive space on a host server but can be difficult to manage due to the parent-child relationship. The parent-child relationship may also cause performance issues. Figure 3.2 shows the Configure Disk screen of the New Virtual Hard Disk wizard. Differencing disks will be discussed in further detail in Chapter 4, “Creating Virtual Machines.”

**FIGURE 3.2** Configuring differencing to use a parent disk
You need to establish a default location for storing your VHDs (see Figure 3.3). Depending on your network and your hard drive setups, this can be a critical decision. Do you want to store your VHDs locally on the server, or on the network? Keep in mind that the host system has the ability to store VHD files on an accessible file system, internal hard drive, or a storage area network (SAN).

**FIGURE 3.3** Specifying the default storage location for VHDs

![Specifying the default storage location for VHDs](image)

This setting will be your default location for all VHDs from this point on, but you have the ability to change the location of any VHD even after this setting is configured. Figure 3.4 shows the installation of a new VHD and the option to change the storage location of the VHD.

**FIGURE 3.4** Setting a storage location for a new VHD

![Setting a storage location for a new VHD](image)
Chapter 3 • Configuring Hyper-V

Exercise 3.1 shows you how to set the default VHD file location in the Hyper-V Manager.

**EXERCISE 3.1**

**Setting the Default Storage Location for VHDs**

1. Choose Start > Administrative Tools > Hyper-V Manager.
2. In the Hyper-V Manager, click on your Computer Name, and then in the Actions pane, click Hyper-V Server Settings.
3. In the Hyper-V Settings dialog box, click Virtual Hard Disks.
4. In the field “Specify the default folder to store virtual hard disk files,” type the folder name, such as C:\Sysbex\VHD, and then click Apply.
5. In the Hyper-V Settings dialog box, click Virtual Machines.
6. In the field “Specify the default folder to store virtual machine files,” type the folder name, such as C:\Sysbex\VM, and then click OK.

**Using Pass-Through Disk Access**

You may be familiar with Microsoft’s earlier virtualization products, Windows Virtual Server and Virtual PC. Hyper-V, Microsoft’s newest virtualization technology, has many new features in the area of virtual machine storage. One such feature is called *pass-through disk access*.

This feature allows Hyper-V to work without the use of VHDs. Virtual machines can access a file system directly through the use of pass-through disk access, thus eliminating the need for VHDs. VHDs are inaccessible to nonvirtualized systems due to the VHD formatting. Pass-through disk access helps solve this problem by allowing the virtual machine to directly access the writable file system. Another advantage is that there is no 2040GB limitation as with VHDs.

So here is another decision for you to make when setting up the Hyper-V storage system: do you use pass-through disk access or VHDs? You must decide whether it’s more important that virtual machines and applications be able to access the disk directly or that you take advantage of the VHD features, such as VHD snapshots (discussed further in this section), differencing, or dynamic VHDs.

After you make your decision, you have to specify how you want to show your host disks to your guest machines. You have the ability to show your disks as either virtual ATA devices or virtual SCSI devices (see Figure 3.5). The disk type does not have to match the way you decide to show the disk to the guest. For example, a SCSI disk can be shown to the guest as an IDE disk and an IDE disk can be shown as a SCSI disk.
The requirements of the guest operating system determine how you will set the drive types. IDE hard drives are drives that the guest system can boot from, but with an IDE drive you can only have four virtual disks (two disks on two controllers). You can set up 256 SCSI virtual disks (64 disks on four controllers), but the system cannot boot up from the virtualized BIOS. If you need your guest systems to have more than four disks, you must use SCSI; if you need your guest systems to boot to the virtual disk, use IDE.

When setting up your disk types, you have the ability to use both IDE and SCSI at the same time. If needed, you can boot off the IDE drive and use the SCSI drives for storage or applications.

**Configuring Virtual Machine Snapshots**

A feature that has become common in the Microsoft Windows world is volume shadow copies. Creating backups of open files is a challenge that all IT personnel have dealt with in their careers. Typically, backup software can't back up files while they are open.
Microsoft includes the Shadow Copy feature with most of its newer operating systems. Before this feature was released, if you ran your Microsoft Exchange mail server 24 hours a day, you had to purchase a special component of your backup software to back up your open Exchange files. Now, you can use the Shadow Copy feature to “take a picture” of the open files and then copy the picture to a location for recoverability.

Using Hyper-V, you can enjoy the advantages of shadow copies with your virtual machines. Hyper-V allows you to set up virtual machine snapshots. Hyper-V takes a “snapshot” of your virtual machine and places that copy in a specified location. Using the dialog box shown in Figure 3.6 (see Exercise 3.2 for a step-by-step), you specify the default location for these snapshots.

**FIGURE 3.6** Snapshot File Location

Having virtual machine snapshots gives you a few very important benefits. You have a backup copy of the virtual machine in case of a crash or error, and can quickly recover from any major problems. Also, this feature allows you to make major configuration changes to the operating system (such as adding new software or running updates) without worry. If the installation causes any problems, you can just revert back to a previous snapshot.
Configuration Changes on Your Servers

For all the years I've been in the IT field, one thing that has always amazed me about Microsoft is their patches and updates. I like Microsoft products and I rarely complain about how they work, but one thing that has always bothered me is their product testing. There have been multiple times where I have loaded a patch from Microsoft and had my computer crash. These days, I wait until a patch or update has been out a while to make sure the bugs are worked out before I load the patch or update onto my network computers.

Hyper-V and virtual machine snapshots can help in this situation. Having the ability to revert back to a snapshot if a patch or update causes a problem can solve these issues. Also, Hyper-V can help because, as mentioned in Chapters 1 and 2, you can use a Hyper-V virtual machine environment just for testing. This way, the patches won't be placed on a live server or workstation, and it gives you the advantage as an administrator to evaluate the update before taking it live.

Exercise 3.2 shows you how to set the default location for your snapshots. Keep in mind that once your snapshot is created, you can't change the folder location unless the snapshot is stopped.

**Exercise 3.2**

**Setting the Default Snapshot Locations**

1. Select Start ➔ Administrative Tools ➔ Hyper-V Manager.
2. In the Hyper-V Manager, click on your computer name in the console tree, and then in the Actions pane, click Hyper-V Server Settings.
3. In the Hyper-V Settings dialog box, click Snapshot File Location.
4. In the field "Specify the default folder to Virtual Machine Configuration files," type a folder name, such as C:\Sybex\snapshot, and then click Apply.

Hyper-V allows you to manipulate a virtual hard disk offline using a command-line utility called VHDMount. By using VHDMount, you can work directly on an offline VHD and do maintenance without having to power on the virtual machine.

When you use VHDMount, an undo disk is automatically created by the system. This undo disk records any changes that are completed to the mounted drive. You can use the undo disk to accept or reject the changes.
Chapter 3 • Configuring Hyper-V

Configuring Hyper-V Server Settings

We just finished setting up our default snapshot locations and our default VHD locations, but there are many other server changes that can help optimize your Hyper-V environment.

**BIOS**  When setting up the BIOS for your Hyper-V server, the first thing you can specify is whether the numbers lock (Num Lock) is on or off by default when the Hyper-V server starts (see Figure 3.7).

You can also specify the Startup Order for the operating system. This is the order that your boot devices will be checked to start the operating system. You can boot from a CD, hard drive, network adapter, or a floppy disk.

**FIGURE 3.7** Hyper-V server BIOS settings

**Memory**  You need to have enough memory to handle the workload of the system and some extra for a buffer. A virtual machine only uses memory when it is either running or is paused. To configure the memory option, you must make sure the virtual machine is turned off.
Processors  The number of physical processors you have on your machine determines the number of virtual processors you can set on the Hyper-V server (see Figure 3.8). Other processor configuration options are related to resource control and process functionality. Again, to configure these options, make sure the virtual machine is turned off.

**FIGURE 3.8** Processor settings

**Virtual Machine Reserve (Percentage)**  Here you specify how much of the hardware resources you want to reserve for Hyper-V. This setting will guarantee that the hardware that you reserve for Hyper-V will be available to the virtual machines.

**Virtual Machine Limit (Percentage)**  This option allows you to define the total maximum amount of resources that the virtual machine can use. No matter how many virtual machines are running, this setting always applies.

**Relative Weight**  This value specifies how resources will be allocated to the current virtual machine when more than one virtual machine is running. When multiple virtual machines are running at the same time, they are all competing for the use of the machine’s hardware resources. The Relative Weight setting helps allocate these resources to the virtual machines.
Processor Functionality  This option allows you to limit the processor functionality so that you can load an older operating system (such as Windows NT 4.0) on the virtual machine.

IDE Controller  Here you specify your hard drive or DVD drive. You have the ability to add a controller at this screen. After the drive has been attached to one of your controllers, you can configure the hard drive to use either the virtual hard disk or the physical hard disk.

Hard Drive  In this section you configure how the virtual hard disk is linked to the virtual machine. You can create, edit, remove, and inspect the VHD file (see Figure 3.9).

**FIGURE 3.9**  Hard disk configuration options

> The Network Adapter section of the server settings will be discussed later in the chapter, in the section “Configuring Virtual Networking.”

COM Ports  This setting allows you to set up a named pipe that enables the physical computer to communicate through the use of a virtual COM port. There are two COM (COM1 and COM2) ports that you can configure in Hyper-V.
Diskette Drive This setting allows you to set up a diskette drive in the Hyper-V environment.

Name Name is the first option that you can configure under the management section. This screen (see Figure 3.10) allows you to rename the server and also record notes about the virtual machine.

**FIGURE 3.10** The Name screen of the server settings

Integration Services This screen (Figure 3.11) allows you to choose which services in Hyper-V you would like to offer to the virtual machines. Table 3.1 lists some of these services.

**TABLE 3.1** Integration Services Options

<table>
<thead>
<tr>
<th>Service</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System Shutdown</td>
<td>Allows an administrator to properly shut down a guest operating system by using the Virtualization Management Console</td>
</tr>
<tr>
<td>Time Synchronization</td>
<td>Ensures that the time is synchronized between the host system and the guest operating system</td>
</tr>
</tbody>
</table>
TABLE 3.1  Integration Services Options  (continued)

<table>
<thead>
<tr>
<th>Service</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heartbeat</td>
<td>Verifies that the guest operating system is working properly and is not currently locked up (hung up)</td>
</tr>
<tr>
<td>Backup (Volume Snapshot)</td>
<td>Helps create a backup or snapshot of the virtual machines</td>
</tr>
</tbody>
</table>

FIGURE 3.11  Integration Services screen

Automatic Start Action  This screen (see Figure 3.12) allows you to configure how the virtual machine is going to react when the physical machine is started. When the machine starts, you can have the virtual machine either do nothing or automatically start if it was running when the service stopped, or you can always start the virtual machine automatically. You also have the ability to set an automatic start delay. A start delay can help reduce resource contention among virtual machines.
**FIGURE 3.12** Automatic Start Action screen

![Automatic Start Action screenshot]

**Automatic Stop Action**  This setting allows you to determine how the virtual machine will shut down when the physical machine shuts down. You can choose one of three options: Save The Virtual Machine State, Turn Off The Virtual Machine, or Shut Down The Guest Operating System.

**Release Keys**  Release keys are the key combinations that release tasks. For example, pressing Ctrl+Alt+Delete starts the Task Manager or Windows Security box (logons), but that will not work in Hyper-V. To start the same tasks in Hyper-V, you need to press Ctrl+Alt+End. Table 3.2 shows you some of the Windows key combinations and what the corresponding Hyper-V key combinations are to start the same task.

**TABLE 3.2** Key Combinations

<table>
<thead>
<tr>
<th>Windows Key Combination</th>
<th>Virtual Machine Key Combination</th>
<th>Task Accomplished</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Alt+Delete</td>
<td>Ctrl+Alt+End</td>
<td>Opens Task Manager or Windows Security dialog box</td>
</tr>
<tr>
<td>Alt+Esc</td>
<td>Alt+Insert</td>
<td>Cycles through open programs</td>
</tr>
</tbody>
</table>
TABLE 3.2  Key Combinations  (continued)

<table>
<thead>
<tr>
<th>Windows Key Combination</th>
<th>Virtual Machine Key Combination</th>
<th>Task Accomplished</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Esc</td>
<td>Alt+Home</td>
<td>Displays Windows Start menu</td>
</tr>
<tr>
<td>None</td>
<td>Ctrl+Alt+Left Arrow</td>
<td>Releases the keyboard and mouse from virtual machine.</td>
</tr>
<tr>
<td>None</td>
<td>Ctrl+Alt+Pause</td>
<td>Opens virtual machine in full screen (also releases full screen)</td>
</tr>
</tbody>
</table>

Setting these configuration settings will help you manage your virtual environment more efficiently. Next, let’s take a look at setting role-based access control.

Using Authorization Manager

Authorization Manager allows you to integrate role-based access control into applications. This gives you the flexibility to assign application access to users based on their job functions. Since Hyper-V is a server role, you can use Authorization Manager to work with Hyper-V. For example, users in your domain who are not administrators can still be given permissions to create and modify virtual machines in your organization. You also have the ability to specify certain users to manage only certain virtual machines.

To set up Authorization Manager, you must first create an authorization store, where the role-based access permissions will reside. The permissions can be stored in any one of the following:

- Active Directory Domain Services (AD DS)
- Active Directory Lightweight Directory Services (AD LDS)
- SQL databases
- XML files

If you choose to use AD DS, the function level must be at the Windows Server 2003 level. Function levels are discussed in detail in MCTS: Windows Server 2008 Active Directory Configuration Study Guide by William Panek and James Chellis (Sybex, 2008).

Because Authorization Manager provides role-based access to Windows applications, any application that needs role-based authorization can use this tool. Authorization Manager gives you a centralized location to record all your assigned access and their corresponding application.

After you have installed and configured Authorization Manager, you can use scripts to control how Authorization Manager works. These scripts, called authorization rules, allow you to configure specific control over the way access is given throughout your organization.
Understanding the Configuration Tools and Techniques

Centralized Management

Depending on your network setup and how long you have been in the industry, you may have been in a situation where multiple applications have had multiple sets of permission or access. Years ago, there was no centralized application that showed you all your users and their corresponding role-based access to applications. You would have to go application to application and figure out which users had what access.

The problem becomes difficult when you have multiple administrators doing the same job. Now you may have different administrators assigning different access to multiple people. Also, if your IT department is like many around the world, your department almost never documents anything unless it's mandatory.

This is where Authorization Manager can be helpful. Authorization Manager gives you a centralized location for all administrators to record role-based application access.

Folks in the IT field often don’t like to document IT issues or items. As a consultant and instructor, I have heard this many times: “I don’t document; if they fire me, let them figure out their own network.” I understand what many IT people are thinking, but it is important to document so that later you can go back and see what you did. You may fix an item and six months later come across the same item again; documenting what you did may save you many hours of work and frustration.

When setting up Authorization Manager’s role-based application access, there are two categories of roles that are specifically used:

User Authorization Roles  These are roles set up through Authorization Manager that are based on the user’s job function. You configure role-based access to users to allow them to perform their day-to-day tasks. For example, you might define an accountant role that would include the right to authorize transactions for the organization.

Computer Configuration Roles  These are roles set up through Authorization Manager that are based on the computer’s function. You configure role-based access to a machine for specific tasks to be done. For example, you can configure a machine so that it can be designated as a domain controller, web server, or file server.

When setting up Authorization Manager, you can specify which groups can receive authorization policies. The types of groups are as follows:

Windows Users and Groups  This group includes the Active Directory users, computers, and built-in group objects. The Windows users and groups are used not only for Authorization Manager but throughout the Microsoft domain model.
Application Group  The Application group consists of users, computers, and other security
groups in Authorization Manager. This group is an Authorization Manager group only; it
is not a group of applications but a group of security objects.

LDAP Query Group  This is a type of Application group whose membership is dynamic.
This group uses Lightweight Directory Access Protocol (LDAP) queries to help determine,
as needed, the membership of the group.

Basic Application Groups  This is a type of Application group that is specific to Autoriza-
tion Manager. This group type allows you to specify the members of the group, but it also
allows you to specify who is not a member of the group.

Business Rule Application Group  This is a type of Application group whose members are
created by a script (using VBScript or JScript, for example) at application runtime. This
group allows you the flexibility to determine the criteria of the group membership through
the use of a script.

Windows Server 2008 includes many new features for the Authorization Manager
Microsoft Management Console (MMC) snap-in:

- Authorization stores that can be stored in SQL databases, AD DS, AD LDS, or an
  XML file
- Business rule groups (groups whose membership is configured by a script at applica-
tion runtime)
- Custom object pickers
- API improvements
- Improved auditing

When you are using business and authorization rules in Authorization Manager, you
set the rules by configuring registry settings. In earlier versions the rules were enabled by
default, but this has changed in Windows Server 2008 Authorization Manager, where the
rules are disabled by default. Authorization Manager is available for all editions of Win-
dows Server 2008 in both 32- and 64-bit versions.

In Exercise 3.3 we will start using Authorization Manager by installing the MMC snap-in.
MMC is the application that all other Microsoft applications run through. For example, there
is an MMC snap-in for DNS, DHCP, and Active Directory. Knowing that most administrative
tasks run using the MMC allows you to customize and configure custom administrative con-
sole windows. Let’s say you are responsible for DNS, DHCP, and Authorization Manager; you
can configure an MMC snap-in that has all of these applications in one location.

**EXERCISE 3.3**

**Installing Authorization Manager**

1. Start the Microsoft Management Console by clicking Start > Run. Then type **MMC**
   and click OK.
EXERCISE 3.3 (continued)

2. Select File ➤ Add/Remove Snap-in.

3. In the Available Snap-ins list on the left, select Authorization Manager and click the Add button. Authorization Manager should appear in the Selected Snap-ins window on the right. Click OK.
Chapter 3 • Configuring Hyper-V

**EXERCISE 3.3 (continued)**

4. In the window on the left, click on Authorization Manager. Once it’s highlighted, select Action ➤ New Window From Here.

5. Authorization Manager should now be the only item in the window on the left. Choose File ➤ Save. In the File Name box, type *Authorization Manager.msc*. Save the file in the Administrative Tools folder by choosing Administrative Tools from the Save In drop-down list.

6. Close all MMC windows.
Once the installation of Authorization Manager is complete, it’s time to configure Authorization Manager. One of the first things that we have to do is create a new authorization store. To do this, we must be in the Developer mode of Authorization Manager. In Exercise 3.4 we begin by changing the mode type and then create a new authorization store.

**EXERCISE 3.4**

**Configuring Authorization Manager**

1. To start the Authorization Manager, click Start ➤ All Programs ➤ Administrative Tools, and then click **Authorization Manager.msc**.

2. Once the application opens, click on Authorization Manager in the window on the left. Right-click and choose Options.

3. Make sure that the Developer mode radio button is selected and click OK.

4. To use Authorization Manager, you must create an authorization store. Select Action ➤ New Authorization Store.

5. In the resulting dialog box, make sure the XML File and Schema Version 2.0 radio buttons are selected. In the Store Name box, append **TestStore** to the end of `c:\users\Administrator\Documents\` and click OK.
6. We need to now create an Application group. On the left-hand side, click the Groups folder under TestStore.xml. Right-click on the Groups folder and choose New Application Group.

7. In the Name field, type TestGroup and make sure the Basic Application Group radio button is selected. Click OK.

8. In the center window, select and then right-click the TestGroup group and choose Properties. Click the Members tab. In the Select Additional Members From box, make sure that Windows And Active Directory is selected, and click the Select button.

9. In the Enter The Object Names To Select box, choose a user on your machine and click the Check Names button. After the name is verified, click OK. As you can see here, we chose the Will Panek account for this example. Click OK again when you return to the TestGroup Properties screen.

Authorization Manager can help any organization manage its virtual environment safely. But when it comes to the virtual environment, there are many more areas that we can configure to make virtualization run more efficiently. Let’s take a look at one of the utilities that allows you to manage and configure your virtual world.

**Introducing System Center Virtual Machine Manager**

Microsoft has been using virtualization in the IT field for many years. To make it easier for IT personnel to do their jobs, over the years Microsoft has released applications that use wizards and templates.

Microsoft has also tried to improve the manageability of virtualization by implementing *System Center Virtual Machine Manager* (SCVMM). SCVMM is an easy-to-use and cost-effective application for administrators who are responsible for managing virtual networks. Since SCVMM works with the Windows Server 2008 technology, it allows you to configure and manipulate the physical and virtual machines, consolidate underutilized physical machines, and implement new virtual machines.

One of the advantages of SCVMM is that it provides a centralized location to manage your virtual environment. This allows administrators to manage and configure the virtual machines from one spot. The SCVMM has many other advantages including the following:

**Windows Server 2008 Support**  SCVMM takes full advantage of the Windows Server 2008 operating system and its advantages, which include Hyper-V and all of its benefits along with the Windows Server 2008 64-bit architecture. Windows Server 2008 also supports clustering support and attack hardening.

**Multivendor Virtualization Support**  One of the nice features of using SCVMM is the ability to support multivendor virtualization platforms. This allows the virtual machines to run operating systems other than Microsoft’s. This gives your organization the flexibility to run applications that require non-Microsoft platforms.

**Performance and Resource Optimization**  A new feature is the Performance and Resource Optimization (PRO) utility. PRO can automatically react to failed or badly configured components. One nice advantage of PRO is that it also works with VMware, which allows you to manage your entire virtualized network no matter which virtualization platform you choose.

**Clustering Support**  SCVMM 2008 has new clustering support built in, which allows your organization to improve its availability for managing critical virtual machines. SCVMM can also detect Hyper-V host clusters and then manage those clusters as a single unit.

To install SCVMM, you must first install the .NET Framework (see Exercise 3.5).
EXERCISE 3.5

Installing the .NET Framework

1. Start the Server Manager application by clicking Start ➤ Administrative Tools ➤ Server Manager.
2. On the left-hand side, click the Features link.
3. On the right-hand side, click Add Feature.
4. Click the .NET Framework 3.0 Features check box.
5. An information box appears asking whether you want to install IIS as well. Click OK.
6. On the Select Features screen, click Next.

7. On the Introduction to Web Server (IIS) screen, click Next.
8. The Select Role Services screen appears; accept the defaults and click Next.
EXERCISE 3.5 (continued)


10. On the Installation Results screen, make sure that all components installed successfully and click Close. Close the Server Manager application.

In Exercise 3.6 we will download and install SCVMM. Microsoft allows you to evaluate this product for 120 days. (The SCVMM will be discussed further throughout this entire book.)

At the time that this book was written, the SCVMM 2008 version (vNext) was just released in beta.
**EXERCISE 3.6**

**Downloading and Installing SCVMM 2008**

1. We need to download the SCVMM from Microsoft’s website. On their web site you will need to register for the SCVMM download. Once you get to the download area, save the download to your computer. After the download is complete, run the SCVMM executable. Click the Install button, and files will begin to extract.

![Image of SCVMM installation process](image)

2. Once the files are extracted, the System Center Virtual Machine Manager 2008 Setup screen will appear. Click on the VMM Server setup link.

![Image of SCVMM setup screen](image)
3. On the Microsoft License Terms screen, click the I Accept The Terms Of This Agreement radio licensing button and click Next.

4. You will see the Customer Experience Improvement Program screen next. This screen asks if you would like to participate in an improvement program to make the products better. You can decide how you want to respond. Read both questions and choose one of the radio buttons, and then click Next.

5. At the product registration screen, enter your name and your company name if you have one. Click Next.
Chapter 3 • Configuring Hyper-V

EXERCISE 3.6 (continued)

6. The Prerequisites Check screen will appear next, and it will automatically check the hardware of your machine. After it verifies that you meet the minimum requirements, click Next.

7. The Installation Settings screen will then ask you to choose an installation path for the install files. Accept the defaults and click Next.
EXERCISE 3.6 (continued)

8. The next screen asks you to either install SQL Server 2005 Express Edition or point to a previously installed version of SQL Server 2005. Click Install SQL Server 2005 Express Edition SP2 and then click Next.
9. The Library Share Settings screen appears, which allows you to create a new library share or use an existing one. The library share is the location of the virtual machine library, and enables you to make resources available when creating new virtual machines. Choose the Create A New Library Share radio button and click Next.

10. The Port Assignment screen asks you to choose which port numbers you want to use when setting up SCVMM. The default ports are 8100, 80, and 443. Port 80 is the HTTP default setting, and port 443 is secure HTTP (HTTPS). Accept the defaults and click Next.
11. On the Summary Of Settings screen, verify your settings and click the Install button.

12. After the installation, make sure the Check For The Latest Virtual Machine Manager Updates check box is selected and then close the installation utility by clicking Close.
Chapter 3 • Configuring Hyper-V

The SCVMM utility is a major component in your virtualization toolbox. It allows you to have one application that all administrators can use to configure your entire virtualized infrastructure. When you are setting up virtualization, one component that you must configure is your virtual network. So let’s take a look at virtual networking.

Configuring Virtual Networking

When you set up virtualization, you are creating a virtual network. Before we discuss a virtual network, let’s explore a normal network and see how it works. This will help you understand how a virtual network operates.

When setting up a network, you normally have a server machine and then you have client machines. The client machines connect to the server machine to access physical resources (files, folders, applications, etc.) or networking services (DNS, DHCP, etc.). You need physical machines to run the server operating systems. These machines must be able to handle the higher-end operating systems. When client machines connect to the server systems, they normally connect using the server name or the TCP/IP address of the server.

Virtual networking works a lot like normal networking except that you don’t need as much hardware. You instead set up virtual servers that run on your network just like physical servers. The end users (clients) cannot tell the difference between a physical server and a virtual server.

When setting up virtual servers, you assign those virtual servers Ethernet adapters (just like a normal server) and give those Ethernet adapters TCP/IP addresses and Media Access Control (MAC) addresses. When setting up virtual network adapters, keep in mind that you can assign only one virtual network to a physical adapter. Also, wireless network adapters can’t be used with Hyper-V virtual machines. You must be physically plugged into your network when setting up virtual networking. Your clients can still be wireless but not your Hyper-V virtual machines.

Utilities are available to help you with the configuration tasks. For example, Microsoft’s Virtual Network Manager, shown in Figure 3.13, lets you add, remove, modify, and manage virtual networks from one location.

When discussing virtual networking, there are a few concepts that you need to understand. These concepts will not only help you set up a Hyper-V network, they are also covered in detail on the Hyper-V exam.

Virtual Local Area Network (VLAN) A virtual local area network (VLAN) refers to the virtual network. It is the virtual network that the client machines access to get to their resources and network services.

Virtual Switches Virtual switches help Hyper-V secure and control the network packets that enter and exit the virtual machines. You can limit the communications to or from a virtual machine and the VLAN. When setting up your network adapters, you can associate a single virtual switch with that adapter.
VLAN Tagging  One problem that a virtual network could run into is that you have multiple virtual machines using the same physical network adapter. This is where VLAN tagging comes in handy. VLAN tagging allows multiple virtual machines on the same physical machine to use the same physical network adapter in that machine.

External/Private/Internal Settings  When setting up your network adapters you have three choices. You can configure the communications to use the External setting, Internal setting, or the Private setting:

  External  This option creates a connection from the physical adapter and the virtual machine. It allows a virtual machine to access the network through the network adapter.

  Internal  This option allows communications between the virtualization servers and the virtual machines.

  Private  This option provides communications only among the virtual machines and allows the virtual machines to talk to each other only.

PXE Boot  Hyper-V supports the Pre-Boot Execution (PXE) environment on the virtual network adapters that you configure. PXE booting allows a network card to be configured
without the need of a hard drive or operating system. This enables the network cards to access a network without operating system assistance. The host network must be configured to use PXE if you want to take advantage of this feature.

**Virtual Machine Quarantine** One advantage to using Hyper-V on Windows Server 2008 is that you get to use many of the services offered with the Windows Server 2008 environment. One of those services is the Network Access Protection (NAP) feature. NAP enables you to quarantine machines that do not meet specific network or corporate policies. The noncompliant machines will not be permitted to access the network until they comply with the organization’s policies. NAP is discussed in detail in *MCTS: Windows Server 2008 Network Infrastructure Configuration Study Guide* by William Panek, Tylor Wentworth, and James Chellis (Sybex, 2008).

In Exercise 3.7 we will use the Virtual Network Manager to configure a network adapter in Hyper-V. The Virtual Network Manager is included with the Hyper-V Manager.

**EXERCISE 3.7**

**Creating a Virtual Network Connection**

1. Start the Hyper-V Manager by clicking Start ➔ Administrative Tools ➔ Hyper-V Manager.
2. Open the Virtual Network Manager by clicking Virtual Network Manager in the right-hand window under Actions.
3. Make sure that External is highlighted under What Type Of Virtual Network Do You Want To Create? and click Add.
4. On the New Virtual Network screen, type **NIC1** in the Name field. In the Connection Type section, make sure the External radio button is selected and then choose your network adapter. Click OK.

5. A warning box may appear stating that you are going to temporary lose your network connection while the virtual adapter is being configured. Click Yes.

6. Close the Hyper-V Manager.

We will discuss how to use and configure this new adapter we just created in Chapter 4, “Creating Virtual Machines.”

A solid understanding of virtual networking is critical because the virtual environment runs within the virtual network. Being able to create virtual adapters and set up virtual networking are key components of setting up a virtual environment. Now let’s take a look at configuring Hyper-V remotely.
Configuring Remote Administration

When you are working on a network, it may not always be possible to go directly to the Hyper-V server to make changes. You may have to connect to the server remotely instead.

In today’s world, home is just an extension of work. In many organizations, working from home or being available on a 24-hour basis is a requirement. The last thing you want to do is drive all the way to the office because a service or server is not working properly. It is much easier to configure remote access.

You can configure the Hyper-V server in several ways. First, you can use another server to connect to the Hyper-V host server (see Figure 3.14). To do this, you just install the Hyper-V role to the server and then connect to the other server through the Hyper-V MMC snap-in.

**FIGURE 3.14** Connecting to a Hyper-V server

You can also install the Hyper-V Manager on the Windows Vista operating system as long as it has Service Pack 1 or higher installed. Once you install the Hyper-V management tool, it looks and feels just like the server’s version of the Hyper-V Manager. To manage Hyper-V from Vista, you must download the Hyper-V management tools from the Microsoft website:


Another way you can administer a Hyper-V server remotely is through the use of the Remote Desktop Protocol (RDP). RDP allows you to connect directly to the Hyper-V server and have an RDP session with the server. When using RDP, it looks as if you are sitting in front of the server console. Microsoft also offers a utility called the Virtual Machine Connection (vmconnect.exe) that uses the RDP protocol to establish a connection.
To use RDP, you may have to configure your router to allow port 3389. Port 3389 is the standard default RDP port. To connect to the server by using RDP, you need to use a RDP client. RDP is included with Windows Server, Windows Vista, and Windows XP.

An organization may also use the Virtualization Windows Management Instrumentation (WMI) tool to manage, create, and configure virtual machines. Virtualization WMI allows an administrator to:

- Manage server settings
- Control the status of virtual machines
- Create and configure virtual machines
- Create and configure virtual networking

To use the Virtualization WMI tool, you must use a scripting utility to configure and create WMIs. To write the WMI scripts, you can use C/C++, the Microsoft Visual Basic application, or a scripting language, including Windows PowerShell. If you are new to scripting or need additional scripting hints, go to Microsoft’s website and visit the Script Center (http://www.microsoft.com/technet/scriptcenter/default.mspx).

Another utility that allows you to use scripts to configure Hyper-V is the Windows Remote Management (WinRM) utility. To configure Hyper-V, you can use the WinRM scripting objects, the WinRM command-line utility, or the Windows Remote Shell (WinRS) command-line utility.

No matter which way you decide to gain access remotely, one thing that you must configure is the Windows Firewall (see Figure 3.15). A firewall is a hardware or software device that helps stop unwanted intruders from accessing your network and doing any damage. The Windows Firewall application can stop you from connecting remotely if not configured properly. The Microsoft Firewall is included with the Windows Server 2008 operating system.

In Exercise 3.8 we will check the Windows Firewall and make sure that the Hyper-V and Remote Desktop Protocol (RDP) are both configured so that we can remotely connect to the Hyper-V server.

**FIGURE 3.15** The Windows Firewall
Exercise 3.8

Configuring the Windows Firewall

1. Open the Windows Firewall by clicking Start ➤ Control Panel ➤ Windows Firewall.
2. When the Windows Firewall opens, click the Change Settings link.
3. Make sure the Block All Incoming Connections check box is deselected. Click the Exceptions tab.
4. Select the Hyper-V and Remote Desktop check boxes.

5. Click the Add Port button. In the Name field, type RDP Port. In the Port Number field, type 3389. Select the TCP radio button and click OK.

6. Click OK and close the Windows Firewall.
Configuring the Windows Firewall

Microsoft has included the Windows Firewall application on their operating systems for years now. I must admit that I am not the biggest fan of using the Windows Firewall on client machines. Many organizations will have their clients use the Microsoft Firewall throughout the company. I have had many issues with this in a real-world environment.

For example, I set up a printer a few years ago for a client, and once I installed the printer, it would not print. I worked on it for about an hour and no matter which drivers I installed and no matter what I did, I could not get the printer to print. While I was pulling my hair out for a simple printer issue, I decided to turn off the Windows Firewall on the client machine. As soon as I turned it off, the printer started to print. The printer needed to be bi-directional with the client machine and the Windows Firewall was stopping it from working properly. You can configure the firewall to allow this to work, but it’s just an example of what can happen.

Firewalls are a must item in your organization (especially between your network and the Internet), but using the Windows Firewall on the client machines may cause issues when working with certain devices.

I want to make sure I stress that you need to have firewalls in your organization, but remember, you get what you pay for. Windows Firewall is free with the operating system. Invest in a good network firewall to protect your organization.

Summary

To configure Hyper-V properly, it is important to understand virtual hard disks (VHDs) and the various configuration options. There are three VHD types: fixed size, dynamic, and differencing. Fixed-size VHDs have a set amount of hard disk space, and that amount does not change. Dynamic VHDs only use the amount of space that is currently being used for the VHD. Differencing disks are configured in a parent-child relationship with another disk that stays intact.

Shadow copies are included with Hyper-V virtual machines, and they are called virtual machine snapshots. Virtual machine snapshots will take a copy of your virtual machine and place that copy in a specified location.

Pass-through disk access allows Hyper-V to work without VHDs. Virtual machines can access a file system directly through the use of this feature.
Authorization Manager allows administrators to integrate role-based access control to applications. The System Center Virtual Machine Manager (SCVMM) is an easy-to-use and cost-effective application for administrators who are responsible for managing virtual networks. SCVMM 2008 is a single application that allows you to configure and manage your entire virtual environment.

Virtual networking is the way you configure your virtual environment to work on the physical components to allow other machines to access your virtual resources through the physical network. In this chapter you learned about different virtual network concepts, such as VLANs, virtual switches, VLAN tagging, and the communication settings. One of the advantages that an administrator has is the ability to configure Hyper-V remotely.

In the next chapter we will discuss how to create and manage virtual machines.

Exam Essentials

Understand virtual hard disks (VHDs). A VHD is a virtual hard drive that you install the guest operating system onto. During the installation of the guest operating system, you determine the size and location of the virtual hard disk that the virtual machine will use.

Be able to list the three VHD types. There are three VHD types. Fixed-size VHDs have a set amount of hard disk space, and that amount does not change. Dynamic VHDs only use the amount of space that is currently being used for the VHD. The fixed-size VHD option offers better performance than the dynamic VHDs by eliminating the fragmentation associated with a growing file. Differencing disks are configured in a parent-child relationship with another disk that stays intact. This allows you to change the operating system or data without affecting the parent disk.

Be familiar with virtual machine snapshots. Understand that Microsoft Hyper-V has also included the shadow copies advantages to your virtual machines and they are called Virtual Machine Snapshots. Understand that these virtual machine snapshots will take a copy of your virtual machine and place that copy in a specified location. Understand the recovery and rollback advantages of using virtual machine snapshots.

Understand pass-through disk access. Pass-through disk access allows Hyper-V to work without the use of virtual hard disks (VHD). Virtual machines can access a file system directly, thus eliminating the need for VHDs. Be sure to know that VHDs are inaccessible to nonvirtualized systems due to the VHD formatting. Pass-through disk access helps solve this problem by allowing the virtual machine to directly access the writable file system. Using pass-through disk access allows you to surpass the 2040GB limitation of VHDs.

Know how to use Authorization Manager. Authorization Manager allows you to integrate role-based access control to applications. This gives you the flexibility to assign application access to users based on their job functions.
Understand System Center Virtual Machine Manager. Understand that System Center Virtual Machine Manager is an easy and cost-effective application for administrators that are responsible for managing virtual networks. Since SCVMM works with the Windows Server 2008 technology, understand that SCVMM allows you to configure and manipulate the physical and virtual machines, consolidate underutilized physical machines, and implement new virtual machines.

Know how to implement virtual networking. Be familiar with VLANs, virtual switches, VLAN tagging, and the three communication settings that you can configure. Be able to set up a network adapter in the Virtual Network Manager tool.

Understand how to configure Hyper-V remotely. Know how to remotely configure and maintain Hyper-V remotely. Understand how to configure the Windows Firewall and RDP settings to allow for the remote administration.
Review Questions

1. You are the network administrator for a large organization that uses Windows Server 2008 and Windows Vista. Your organization has decided to use Microsoft Hyper-V to help increase server productivity and reduce hardware costs. You have limited hard disk space for your Hyper-V virtual machines. How should you implement the VHDs?
   A. Use fixed-size VHDs.
   B. Use dynamic VHDs.
   C. Use VHD differencing.
   D. Use Virtual Server 2005 fixed size.

2. You are the network administrator for a large organization that has decided to use Hyper-V. Your manager has asked you to give a presentation on Hyper-V to all the executives. During the presentation someone asks you the maximum size of a VHD. What is your answer?
   A. 1750GB
   B. 1000GB
   C. 3400GB
   D. 2040GB

3. You are the network administrator for Panek Industries. Your organization has decided to implement Hyper-V. You have installed the Hyper-V role and you are getting ready to install your first virtual hard disk (VHD). During the installation of the VHD, a screen asks you what type of disk you want to configure. What are the three options that you have when installing a VHD?
   A. Fixed size
   B. Dynamic
   C. Differencing
   D. All of the above

4. You are the network administrator for a large organization that has decided to use Hyper-V. You decide to purchase new hardware for the installation. When setting up the virtual machines, you realize that you have to have nonvirtualized systems access the virtual machines. How would you configure the virtual machines?
   A. Fixed-size VHD
   B. Dynamic VHD
   C. Differencing
   D. Pass-through disk access
5. You are the network administrator for a mid-sized organization that has decided to use Hyper-V. You are trying to determine which type of hard drives you want to set up in the Hyper-V environment. The hard drive must have the operating system loaded and the machine will need to be booted up from the drive. What type of drive would you set up?
   A. SCSI drive
   B. IDE drive
   C. Fixed-size VHD
   D. Dynamic VHD

6. You are the network administrator for a large organization that has decided to implement Hyper-V. Your boss is concerned about making sure the virtual machines can be recovered in the event of a fatal error or in the event of a rollback. What feature can you tell your boss about to help relieve her concerns?
   A. Virtual Machine VHD Backup tool
   B. Virtual machine snapshots
   C. Virtual Machine Recovery tool
   D. VHDMount utility

7. You are the system administrator for a mid-sized organization. You need to start giving sales users role-based rights to use certain applications, including ASP.NET web applications. What application can you use?
   A. Application Manager
   B. Virtual Machine Manager
   C. Authorization Manager
   D. Hyper-V Manager

8. You are the IT manager for a large organization that has decided to implement Hyper-V. You currently have 25 servers that are all running Microsoft Windows Server 2008 and all of your clients are using either Windows Vista or Windows XP. You want to consolidate 50 percent of your servers to run as virtual machines in Hyper-V. You need to use one management utility to control the Hyper-V virtual machines. Which utility should you use?
   A. System Center Hyper-V Manager
   B. System Center Virtualization Manager
   C. System Center Virtualization MMC
   D. System Center Virtual Machine Manager

9. Your organization has decided to use SCVMM along with Hyper-V. Since you are the IT department head, you have been asked to give a presentation on SCVMM. During the conference with the IT personnel, one of the members asks you to list the advantages of SCVMM. Which of the following would be correct?
   A. Multivendor support
   B. Performance and resource optimization
   C. Clustering support
   D. All of the above
10. You are the network administrator for a large organization. You have implemented Hyper-V and you have decided to use SCVMM. You download and are ready to install the product. Before installing SCVMM, what is a requirement for proper installation?
   A. .NET Framework
   B. Visual Basic scripting
   C. PowerShell
   D. Routing and Remote Access (RRAS)

11. You have been hired as a consultant by a mid-sized organization that would like to install Hyper-V. You install Hyper-V and decide to install SCVMM. You first have to install the .NET Framework before installing the SCVMM program. From where do you install the .NET Framework in the Windows Server 2008 operating system?
   A. Control Panel
   B. Add/Remove Programs
   C. Server Manager
   D. Programs Manager

12. You have been hired as a consultant for a small real estate office. The organization wants you to set up a Windows Server 2008 machine along with 25 Windows Vista clients. They want you to be able to support the network remotely. You have decided to use RDP to connect and configure the server remotely. The office uses a small router for network connectivity to the Internet. You want to configure that router to forward the RDP port to the new server that you set up. Which port number would you use for port forwarding?
   A. 3390
   B. 3386
   C. 3398
   D. 3389

13. You have been hired as a consultant for a doctor’s office. The office wants you to set up a Windows Server 2008 machine with the Microsoft Firewall. They want you to be able to support Hyper-V remotely using RDP. You need to configure the firewall to allow for remote Hyper-V and RDP. Which two services do you have to set exceptions on in the Windows Firewall?
   A. Remote Desktop
   B. Remote Assistance
   C. Virtualization
   D. Hyper-V
14. You are the network administrator for a large organization that has decided to start using Hyper-V. Your organization has many programmers on staff who are good at writing scripts. You want to use a scripting utility to manage and maintain your Hyper-V servers. Which scripting utility can you use?
   A. Virtualization WMD
   B. Virtualization WMI
   C. Virtualization WDS
   D. Virtualization WWF

15. You are the network manager for a small IT department. You have hired a new administrator who is going to be responsible for managing the Hyper-V environment. You do not want the new administrator to work in the computer room so all of his administration will be done remotely. Which operating systems can you install on his machine to allow him to manage Hyper-V remotely? (Choose all that apply.)
   A. Windows Vista with Service Pack 1
   B. Windows Server 2003
   C. Windows Server 2008
   D. Windows XP

16. You are the network administrator for a large organization. You have decided to implement Hyper-V and run all of your servers as virtual machines. You purchase the new server and install Windows Server 2008 and Hyper-V onto the machine. You need to install the network adapter card in Hyper-V. The adapter card will be the one used in the virtual machine that talks to the network. How would you set up the connection type?
   A. External
   B. Internal
   C. Private
   D. Network

17. You are the network administrator for a mid-sized organization that has just installed Hyper-V. You need to configure the network adapter for the Hyper-V console. Which application do you use?
   A. Add/Remove Programs
   B. Networking Services
   C. Virtual Network Manager
   D. WinNS

18. You are the operations manager for a large organization. You have decided to install Hyper-V. After you install the Hyper-V role, you need to set up a virtual machine where the network card gets configured without the need of an operating system. What feature allows this?
   A. PBX
   B. PXE
   C. PDF
   D. PRT
19. You are the network administrator for a large insurance company. Your organization has developed a corporate policy that requires all machines to use the IPSec security protocol. If the computer they are logging in from does not follow this corporate policy, they will be denied access to the network. What can you set up to help enforce the policy?

A. Computer Access Protection  
B. Hyper-V Access Protection  
C. Network Access Protection  
D. Server Access Protection

20. You are the administrator for a large organization that has decided to use Hyper-V and virtual networking. Which of the following is not correct about Microsoft virtual networking?

A. It supports VLAN tagging. 
B. It supports wireless adapters on virtual machines.  
C. It supports PXE boot.  
D. It supports virtual switches.
Answers to Review Questions

1. B. Dynamic VHDs only use the amount of space that is currently being used for the VHD. Use this approach to set up your VHD if hard drive space is limited on your server.

2. D. The maximum size of any virtual hard disk (VHD) is 2040GB.

3. D. You have three options when installing VHDs: fixed size, dynamic, and differencing. Fixed size and dynamic are the two most common settings for Hyper-V. Fixed size means that each VHD is set to a specific hard drive storage space and that space is taken by the system even if the VHD is less than what’s set. Dynamic VHDs only use the space that is currently being used by the VHD. So if a dynamic VHD is set to 16GB but the VHD is currently using only 10GB, then 10GB is all that is currently being used by the dynamic VHD. Differencing allows for a child parent relationship of VHDs.

4. D. Virtual machines can access a file system directly through the use of pass-through disk access, thus eliminating the need for VHDs. VHDs are inaccessible to nonvirtualized systems due to the VHD formatting. Pass-through disk access helps solve this problem by allowing the virtual machine to directly access the writable file system.

5. B. IDE hard drives are drives that the guest OS can boot from, but with an IDE drive you can only have four virtual disks (two disks on two controllers). You can set up 256 SCSI virtual disks (64 disks on four controllers), but you can’t boot up from the virtualized BIOS.

6. B. Hyper-V allows you to set up virtual machine snapshots. Hyper-V will take a copy of your virtual machine and place that copy in a specified location.

7. C. Authorization Manager allows you to integrate role-based access control to applications. You have the flexibility to assign application access to users based on their job functions.

8. D. System Center Virtual Machine Manager is responsible for managing virtual networks. SCVMM allows you to configure and manipulate the physical and virtual machines, consolidate underutilized physical machines, and implement new virtual machines.

9. D. All of these answers are advantages of using SCVMM. SCVMM also allows for centralized management of the virtual machines and includes Windows Server 2008 support.

10. A. A prerequisite for SCVMM is the installation of the .NET Framework. If this is not installed prior to installing SCVMM, the SCVMM installation will not complete.

11. C. The .NET Framework is required to install the SCVMM. To install the SCVMM you must use the Server Manager utility. The Server Manager utility is the application where you install all roles (including Hyper-V) along with the many features that are included with Windows Server 2008.

12. D. When setting up port forwarding for RDP, the standard RDP port number is 3389. You have the ability to change any port number, but by default this is the port that you need to forward.
13. A, D. The two exceptions that you need to make when setting up the Microsoft Firewall are the Hyper-V and the Remote Desktop settings.

14. B. An organization may also use the Virtualization Windows Management Instrumentation (WMI) tool to manage, create, and configure virtual machines. Virtualization WMI allows you to manage server settings, control the status of virtual machines, create and configure virtual machines, and create and configure virtual networking. To use the Virtualization WMI tool, you must use a scripting utility to configure and create WMIs.

15. A, C. You can use Windows Server 2008 and connect to the server through the Hyper-V Manager, or you can also install the Hyper-V Manager on the Windows Vista operating system as long as it has Service Pack 1 or higher installed.

16. A. You have three options when setting up the communications for the network adapter: External, Internal, and Private. External creates a connection from the physical adapter and the virtual machine. This option allows a virtual machine to access the network through the network adapter. Internal allows communications between the virtualization servers and the virtual machines. Private provides communications only between the virtual machines. This enables the virtual machines to talk to each other only.

17. C. Microsoft’s Virtual Network Manager helps an organization set up, configure, and manage a virtual network. It allows you to add, remove, modify, and manage virtual networks from one location.

18. B. Hyper-V supports the Pre-Boot Execution (PXE) environment on the virtual network adapters. PXE booting allows a network card to be configured without the need of a hard drive or operating system.

19. C. One advantage to using Hyper-V on Windows Server 2008 is that you get to use many of the services offered with the Windows Server 2008 environment. One of those services is the Network Access Protection (NAP) feature, which allows you to quarantine machines that do not meet specific network or corporate policies. The noncompliant machines will not be allowed to access the network until they comply with the organization’s policies.

20. B. Wireless network adapters can't be used with Hyper-V virtual machines. You must be physically plugged into your network when setting up virtual networking. Your clients can still be wireless, but not your Hyper-V virtual machines.